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				Introduction

				What is Adobe InDesign, and what can it do for you? In its more than a decade in existence, InDesign has become the most powerful publishing application, one that lets you work the way you want to work. You can use InDesign as a free-form but manual approach to layout, or as a structured but easily revised approach. The fact that you can choose which way to work is important for both novice and experienced users because there is no single, correct way to lay out pages. Sometimes (for example, if your project is a one-time publication, such as an ad), creating a layout from scratch — almost as if you were doing it by hand on paper — is the best approach. And sometimes using a highly formatted template that you can modify as needed is the way to go: You don’t need to reinvent the wheel for documents that have a structured and repeatable format, such as books and magazines.

				InDesign can handle sophisticated tasks, such as glossy magazines and high-impact ads, but its structured approach to publishing also makes it a good choice for newspapers, newsletters, and books. InDesign is also a good choice for corporate publishing tasks, such as proposals and annual reports. In all cases, you can design for printing on paper or electronic distribution as Adobe Acrobat Portable Document Format (PDF) files. Plug-in software from other vendors adds extra capabilities.

				Plus, you can use InDesign as the starting point for Web and Flash documents. These electronic documents can include interactive features, such as page transitions, hyperlinks, and buttons to play sounds or a movie.

				About This Book

				After you get the hang of it, InDesign is quite easy to use. At the same time, it’s a powerful publishing program with a strong following among the ranks of professional publishers — and the latest InDesign CS4 version is certain to reinforce that position. Part of its success is due to the fact that its interface is like that of its sister applications, Adobe Illustrator and Adobe Photoshop, which are also components of the Adobe Creative Suite.

				If you’re just getting started with InDesign, welcome! I hope you’ll find the information in these pages to be helpful in getting you started.

				Conventions Used in This Book

				This book covers InDesign on both Macintosh and Windows. Because the application is almost identical on both platforms, I point out platform- specific information only when it’s different — and that’s very rare. I’ve used Macintosh screen shots throughout; Windows screen shots are usually identical, except for the dialog boxes to open, save, and export files — these are arranged differently on Macs and PCs (for all programs, not just InDesign), but the relevant options to InDesign are the same. If you’re a Windows user, a quick look at Adobe’s documentation, which shows Windows screens, can show you how the interfaces are nearly identical. So don’t worry about them.

				Here are some other conventions used in this book:

				Menu commands: They’re listed like this: WindowPages. That means go to the Window menu and choose the Pages option from it. In almost every case, the menu command sequences are the same for Mac and Windows users; in a very few cases, they differ (such as the Preferences menu option and the Configure Plug-ins menu option), so I note these differences where they exist by putting the Mac menu sequence first and then the Windows one.

				[image: newfeature.eps] InDesign CS4 has an annoying new feature of hiding menu options from you. The goal is to be less intimidating, but it also means that if you don’t know what InDesign can do, you won’t find out by looking at the menus. Fortunately, you can tell InDesign to show you all the menus all the time so that no features are hidden. Here’s how: Choose WindowWorkspaceShow Full Menus. This book assumes you’ve turned the menus all on.

				Key combinations: If you’re supposed to press several keys together, I indicate that by placing a plus sign (+) between them. Thus, Shift+Ô+A means press and hold the Shift and Ô keys and then press A. After you’ve pressed the A key, let go of all the keys. I also use the plus sign to join keys to mouse movements. For example, Alt+drag means to hold the Alt key when dragging the mouse.

				Note that the Macintosh sequence comes first, followed by the Windows equivalent.

				Pointer: The small graphic icon that moves on the screen as you move your mouse is a pointer (also called a cursor). The pointer takes on different shapes depending on the tool you select, the current location of the mouse, and the function you are performing.

				Click: This means to quickly press and release the mouse button once. Many Mac mice have only one button, but some have two or more. All PC mice have at least two buttons. If you have a multibutton mouse, click the leftmost button when I say to click the mouse.

				Double-click: This tells you to quickly press and release the mouse button twice. On some multibutton mice, one of the buttons can function as a double-click. (You click it once, but the computer acts as if you clicked twice.) If your mouse has this feature, use it; it saves strain on your hand.

				Right-click: A feature first implemented on Windows, but present on Macs since the late 1990s, this means to click the right-hand mouse button. If your Mac has only one button, hold the Control key when clicking the mouse button to do the equivalent of right-clicking in programs that support it. Mac OS X automatically assigns the right-hand button on a multibutton mouse to the Control+click combination; if your mouse came with its own System Preference, you can often further customize the button actions.

				Dragging: Dragging is used for moving and sizing items in an InDesign document. To drag an item, position the mouse pointer on the item, press and hold down the mouse button, and then slide the mouse across a flat surface.

				What You’re Not to Read

				[image: TechnicalStuff.eps] If you see any text in this book that has this icon next to it, feel free to skip right over to the next paragraph. This icon alerts you to geeky information that you don’t need to know to use InDesign. I just couldn’t help giving you a little extra-credit information in case you were a budding geek like me.

				Foolish Assumptions

				Although this book has information that any level of layout artist or production editor needs to know to use InDesign, this book is primarily for those of you who are fairly new to the field, or who are just becoming familiar with the program. I try to take the mystery out of InDesign and give you guidance on how to create a bunch of different types of documents.

				I don’t assume that you’ve ever used InDesign (or any publishing program). But I do assume that you have a basic knowledge of Macintosh or Windows — enough to work with files and applications. And I assume that you have basic familiarity with layout design, such as knowing what pages, margins, and fonts are. But I don’t expect you to be an expert in any of these areas — nor do you have to be!

				How This Book Is Organized

				This book contains eight parts. I also include some bonus content on the InDesignCentral Web site (www.InDesignCentral.com).

				Part I: Before You Begin

				Designing a document is a combination of science and art. The science is in setting up the structure of the page: How many places will hold text, and how many will hold graphics? How wide will the margins be? Where will the page numbers appear? You get the idea. The art is in coming up with creative ways of filling the structure to please your eyes and the eyes of the people who will be looking at your document.

				In this part, I tell you how to navigate your way around InDesign using the program’s menus, dialog boxes, panels, and panes. I also explain how to customize the preferences to your needs.

				Part II: Document Essentials

				Good publishing technique is about more than just getting the words down on paper. It’s also about opening, saving, adding, deleting, numbering, and setting layout guidelines for documents. This part shows you how to do all that and a lot more, including tips on setting up master pages that you can use over and over again. You also find out how to create color swatches for easy reuse in your documents.

				Part III: Object Essentials

				This part of the book shows you how to work with objects: the lines, text frames, graphics frames, and other odds and ends that make up a publication. You also discover how to apply some really neat special effects to them.

				Part IV: Text Essentials

				When you think about it, text is a big deal when it comes to publishing documents. After all, how many people would want to read a book with nothing but pictures? In this part, I show you how to create and manipulate text, in more ways than you can even imagine.

				Part V: Graphics Essentials

				Very few people would want to read a book with nothing but text, so this part is where I show you how to handle graphics in InDesign — both importing them from the outside and creating your own within InDesign.

				Part VI: Getting Down to Business

				InDesign is really good at handling the many kinds of documents that tend to be used in businesses, such as manuals, annual reports, and catalogs. This part shows you how to create tables, handle footnotes, create indexes, manage page numbering across multiple chapters in a book, and use text variables to make InDesign update text as needed based on the document’s current context.

				Part VII: Printing and  Multimedia Essentials

				Whether you’re printing a publication or simply creating a PDF file for readers to download from a Web site, you still need to understand the basics of outputting an InDesign document. This part is where I show you how to set up your output files, manage color, and work with service bureaus. You also find out about creating multimedia documents — those with movies, sound, hyperlinks, and buttons — for distribution as PDF files, Flash files, and Web pages.

				Part VIII: The Part of Tens

				This part of the book is like the chips in the chocolate chip cookies; you can eat the cookies without them, but you’d be missing a really good part. It’s a part that shows you some important resources that can help you make the most of InDesign.

				Icons Used in This Book

				So that you can pick out parts that you really need to pay attention to (or, depending on your taste, to avoid), I use some symbols, or icons, in this book.

				[image: newfeature.eps] When you see this icon, it means I am pointing out a feature that’s new to InDesign CS4.

				[image: Tip.eps] If you see this icon, it means that I’m mentioning some really nifty point or idea that you may want to keep in mind as you use the program.

				[image: Remember.eps] This icon lets you know something you’ll want to keep in mind. If you forget it later, that’s fine, but if you remember it, it will make your InDesign life a little easier.

				[image: Warning(bomb).eps] If you skip all the other icons, pay attention to this one. Why? Because ignoring it can cause something really, really bad or embarrassing to happen, like when you were sitting in your second-grade classroom waiting for the teacher to call on you to answer a question, and you noticed that you still had your pajama shirt on. I don’t want that to happen to you!

				[image: TechnicalStuff.eps] This icon tells you that I am about to pontificate on some remote technical bit of information that may help explain a feature in InDesign. The technical info will definitely make you sound impressive if you memorize it and recite it to your friends.

				Where to Go from Here

				If you’re a complete beginner, I suggest you read the book’s parts in the order I present them. If you haven’t used InDesign before but you have used other layout programs, do read Part I first to get in the InDesign frame of mind and then explore other parts in any order you want. If you have used InDesign before, peruse them in any order you want, to see what’s changed.

				As you gain comfort with InDesign, you’ll be surprised how much you can do with it. And when you’re ready to discover more, take advantage of the wealth of resources out there to go the next level. The InDesignCentral Web site (www.InDesignCentral.com) can help you do that.

			

		

	
		
			
				Part I

				Before You Begin
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			In this part . . .

				You have your copy of InDesign, and you’d like some basic information on how to get started, right? Well, you’ve come to the right place. This part helps you sail smoothly through InDesign and gives you a general idea of what InDesign can do. I explain the layout approaches you can take, as well as how to set up InDesign to work the way you work. 

				Along the way, you find out how to navigate the plethora of panels, menus, tools, and shortcuts that can seem overwhelming at first, but which soon become second nature as you gain experience using the program. Welcome aboard!

			

			
		

	
		
			
				Chapter 1

				Understanding InDesign Ingredients

				In This Chapter

				Getting acquainted with the InDesign approach

				Figuring out global versus local control

				Getting up to speed on the InDesign vocabulary

				Exploring the document window

				Surveying the top tools

				Becoming familiar with tools and panels

				Discovering what’s in the menus

				Starting to use a new software application is not unlike meeting a new friend for the first time. You take a long look at the person, maybe ask a few questions, and begin the process of becoming acquainted. (If you’re not new to InDesign but are new to the CS4 version, it’s like seeing a friend you haven’t seen in a while — you observe any changes and catch up on what’s happened in the meantime.)

				Just as it’s worthwhile to find out the likes and dislikes of a new friend, it’s also worth your time to wrap your head around InDesign’s unique style and approaches. When you do so, you’ll find it much easier to start using InDesign to get work done.

				This chapter explains where to look in InDesign for the features and capabilities you need to master. (For a quick look at what’s new to version CS4, check out Chapter 25.) I introduce you to the process that InDesign assumes you use when laying out documents, explain some of the terms you’ll encounter throughout the book, describe the unique interface elements in the document window, survey the most commonly used tools, and explain how InDesign packages much of its functionality through an interface element called a panel.

				[image: newfeature.eps] InDesign CS4 has an annoying new feature of hiding menu options from you. The goal is to be less intimidating, but it also means if you don’t know what InDesign can do, you won’t find out by looking at the menus. Fortunately, you can tell InDesign to show you all the menus all the time, so no features are hidden. Here’s how: Choose WindowWorkspaceShow Full Menus. This book assumes that you’ve turned the menus all on.

				Understanding Global and Local Control

				The power of desktop publishing in general, and InDesign in particular, is that it lets you automate time-consuming layout and typesetting tasks while at the same time letting you customize each step of the process according to your needs.

				What does that mean in practice? That you can use global controls to establish general settings for layout elements, and then use local controls to modify those elements to meet specific requirements. The key to using global and local tools effectively is to know when each is appropriate.

				Global tools include

				General preferences and application preferences (see Chapter 2)

				Master pages and libraries (see Chapter 5)

				Character and paragraph styles (see Chapter 13)

				Table and cell styles (see Chapter 19)

				Object styles (see Chapter 9)

				Sections and page numbers (see Chapter 4)

				Color definitions (see Chapter 6)

				Hyphenation and justification (see Chapter 14)

				Styles and master pages are the two main global settings that you can expect to override locally throughout a document. You shouldn’t be surprised to make such changes often because although the layout and typographic functions that styles and master pages automate are the fundamental components of any document’s look, they don’t always work for all the specific content within a publication. (If they did, who’d need human designers?!)

				Local tools include

				Frame tools (see Part III, as well as Chapter 16)

				Character and paragraph tools (see Chapters 14 and 15)

				Graphics tools (see Part V)

				Keep your bearings straight

				A powerful but confusing capability in InDesign is something called a control point. InDesign lets you work with objects from nine different reference points — any of the four corners, the middle of any of the four sides, or the center — such as when positioning the object precisely or rotating the object. You choose the active reference point, or control point, in the Control panel or Transform panel, using the grid of nine points arranged in a square.


				By default, InDesign uses the central reference point as the control point, which is great for rotating an object, but can lead to confusion when you enter in the X and Y coordinates to place it precisely. That’s because most people use the upper-left corner of an object when specifying its coordinates, not the center of the object. Be sure to change the control point to the upper-left reference point whenever entering X and Y coordinates in the Control or Transform panels.


				How do you change the control point? That’s easy: Just click the desired reference point in that preview grid. The control point will be black, whereas the other reference points will be white.

				Choosing the right tools for the job

				Depending on what you’re trying to do with InDesign at any given moment, you may or may not immediately know which tool to use. If, for example, you maintain fairly precise layout standards throughout a document, using master pages is the way to keep your work in order. Using styles is the best solution if you want to apply standard character and paragraph formatting throughout a document. When you work with one-of-a-kind documents, on the other hand, designing master pages and styles doesn’t make much sense — it’s easier just to format elements as you create them.

				For example, you can create drop caps (large initial letters set into a paragraph of type, such as the drop cap that starts each chapter in this book) as a character option in the Character panel, or you can create a paragraph style (formatting that you can apply to whole paragraphs, ensuring that the same formatting is applied each time) that contains the drop-cap settings and then apply that style to the paragraph containing the drop cap. Which method you choose depends on the complexity of your document and how often you need to perform the action. The more often you find yourself taking a set of steps, the more often you should use a global tool (like character and paragraph styles) to accomplish the task.

				Fortunately, you don’t need to choose between global and local tools while you’re in the middle of designing a document. You can always create styles from existing local formatting later. You can also add elements to a master page if you start to notice that you need them to appear on every page.

				Specifying measurement values

				Another situation in which you can choose between local or global controls is specifying measurement values. Regardless of the default measurement unit you set (that is, the measurement unit that appears in all dialog boxes and panels), you can use any unit when entering measurements in an InDesign dialog box. For example, if the default measurement is picas, but you’re new to publishing and are more comfortable working in inches, go ahead and enter measurements in inches.

				InDesign accepts any of the following codes for measurement units. (Chapter 2 explains how to change the default measurements.) Note that the x in the following items indicates where you specify the value, such as 2i for 2 inches. It doesn’t matter whether you put a space between the value and the code: Typing 2inch and typing 2 inch are the same as far as InDesign is concerned:

				xi or x inch or x" (for inches)

				xp (for picas)

				xpt or 0px (for points)

				xc (for ciceros, a European newspaper measurement

				xag (for agates, an American newspaper measurement)

				xcm (for centimeters)

				xmm (for millimeters)

				[image: Tip.eps] You can enter fractional picas in two ways: in decimal format (as in 8.5p) and in picas and points (as in 8p6). Either of these settings results in a measurement of 81⁄2 picas. (A pica contains12 points.)

				What to do when you make a mistake

				InDesign is a very forgiving program. If you make a mistake, change your mind, or work yourself into a complete mess, you don’t have to remain in your predicament or save your work. InDesign offers several escape routes. You can


				Undo your last action by choosing EditUndo (Ô+Z or Ctrl+Z). (You can’t undo some actions, particularly actions such as scrolling that don’t affect any items or the underlying document structure.) You can undo multiple actions in the reverse order in which they were done by repeatedly choosing EditUndo (Ô+Z or Ctrl+Z); each time you undo, the previous action is undone.


				Redo an action you’ve undone by choosing EditRedo (Shift+Ô+Z or Ctrl+Shift+Z). Alternatively, choosing Undo and Redo is a handy way of seeing a before/after view of a particular change. As with undo, you can redo multiple undone actions in the reverse of the order in which they were undone.

				Mastering Basic InDesign Vocabulary

				All industries have their jargon to describe unique approaches, tools, attributes, and specifications. Publishing is no different. Its vocabulary includes pica, kerning, crop, and color model. But because programs like InDesign bring a once-specialized capability to the masses, the terms are sometimes used incorrectly. Sometimes, they’re replaced with general terms to make nonprofessional users feel less threatened, but that substitution ends up confusing professional printers, people who work in service bureaus, and Internet service providers. Throughout this book, I define other publishing terms as they come up.

				In addition to using publishing-industry vocabulary, InDesign comes with its own specific terminology, much of it adopted from other Adobe products. Terms to know include the following:

				Frame: The container for an object. A frame can hold text, a graphic, or a color fill.

				Link: The connection to a graphics or text file that you import, or place, into an InDesign document. The link contains the file’s location and its last modification date and time. A link can reference any graphics or text file that you’ve imported into a layout. InDesign can notify you when a source text or graphics file has changed so that you can choose whether to update the version in your layout.

				Package: The collection of all files needed to deliver a layout for printing.

				PDF: The Adobe Portable Document Format, which has become the standard for sharing electronic documents. No matter what kind of computer it’s viewed on (Windows, Macintosh, Palm, or Unix), a PDF document displays the original document’s typography, graphics representation, and layout. With InDesign, you can place PDF files as if they were graphics, and you can also export its InDesign pages to PDF format.

				Plug-in: A piece of software that loads into, and becomes part of, InDesign to add capabilities to the program.

				Stroke: The outline of an object (whether a graphic, line, or individual text characters) or frame.

				Thread: The connections between text frames that let a story flow from one frame to another.

				Discovering the Document Window

				In InDesign, you spend lots of time working in document windows — the “containers” for your documents. Each document, regardless of its size, is contained within its own document window.

				The best way to get familiar with the InDesign document window is by opening a blank document. Simply choosing FileNewDocument (Ô+N or Ctrl+N) and clicking OK opens a new document window. Don’t worry about the settings for now — just explore.

				Figure 1-1 shows all the standard elements of a new document window. I won’t bore you by covering interface elements that are standard to all programs. Instead, the rest of this section focuses on InDesign-specific elements.

				
				Figure 1-1:  The document window is where you work on documents.

			

				[image: 388488-fg0101.eps]
				
				[image: TechnicalStuff.eps] The Version Cue pop-up menu lets you see the current status of a document in a shared workgroup setup. You can ignore this expert feature. The new Preflight pop-up menu helps deal with any issues that can affect printing, as Chapter 23 explains. And the new Search menu lets you look for files on your computer and in Adobe Bridge.

				Rulers

				Document windows display a horizontal ruler across the top and a vertical ruler down the left side. As shown in Figure 1-1, the horizontal ruler measures from the top-left corner of the page across the entire spread, and the vertical ruler measures from the top to the bottom of the current page. These rulers are handy for judging the size and placement of objects on a page. Even experienced designers often use the rulers while they experiment with a design.

				Both rulers display increments in picas unless you change the measurement system for each ruler in the Units & Increments pane of the Preferences dialog box. Choose InDesignPreferencesUnits & Increments (Ô+K) or EditPreferencesUnits & Increments (Ctrl+K) to open the Preferences dialog box. Your choices include inches, picas, points, decimal inches, ciceros, agates, millimeters, and centimeters.

				[image: Tip.eps] If you change the ruler measurement system when no documents are open, the rulers in all new documents will use the measurement system you selected. If a document is open when you make the change, the rulers are changed only in that document.

				[image: TechnicalStuff.eps] You can also create your own measurement system by choosing Custom. Most people should ignore this option, but sometimes it can make sense, such as setting the ruler to match the line spacing, so that you can measure number of lines in your ruler.

				If your computer has a small monitor and the rulers start to get in your way, you can hide them by choosing ViewHide Rulers (Ô+R or Ctrl+R).

				Zero point

				The point where the rulers intersect in the upper-left corner of the page is called the zero point. (Some people call it the ruler origin.) The zero point is the starting place for all horizontal and vertical measurements.

				If you need to place items in relation to another spot on the page (for example, from the center of a spread rather than from the left-hand page), you can move the zero point by clicking and dragging it to a new location. Notice that the X: and Y: values in the Control panel update as you drag the zero point so that you can place it precisely.

				If you change the zero point, it changes for all pages or spreads in the document. You can reset the zero point to the upper-left corner of the left-most page by double-clicking the intersection of the rulers in the upper-left corner.

				[image: TechnicalStuff.eps] If you move the zero point, all the objects on the page display new X: and Y: values even though they haven’t actually moved. Objects above or to the left of the zero point will show negative X: and Y: values, and the X: and Y: values of other objects will not relate to their actual position on the page or spread.

				You can lock the zero point, making it more difficult to accidentally change it. Control+click or right-click the ruler origin and choose Lock Zero Point from the menu that appears. (The Unlock Zero Point command is right there as well, so you can just as easily unlock it.) Locking the zero point is a good idea because it will remind anyone working on your document that you prefer that they not fiddle with the zero point.

				Pasteboard

				The white area that surrounds the page is called the pasteboard. It’s a workspace for temporarily storing objects. The pasteboard above and below each page or spread is an inch deep. The pasteboard at both left and right of a page or spread is just as wide as the page. For example, a spread composed of two 8-inch-wide pages has 8 inches of pasteboard to the left and 8 inches of pasteboard to the right, plus 1 inch of pasteboard above and 1 inch below.

				[image: Tip.eps] You can make the height of the pasteboard above and below pages something other than the default of 1 inch. To do so, open the Guides & Pasteboard pane of the Preferences dialog box and choose a new value for the Minimum Vertical Offset field. (Choose InDesignPreferencesGuides & Pasteboard [Ô+K] or EditPreferencesGuides & Pasteboard [Ctrl+K] to open the Preferences dialog box.)

				Application frame and bar

				[image: newfeature.eps] InDesign CS4 introduces the application frame. Windows users will already know what an application frame is, though it never had a name: All the elements of InDesign — its panels, document windows, and so on — were confined into a window with a gray background. By contrast, on a Mac, all these elements floated freely, so folders, icons and other applications could be visible “underneath” InDesign’s elements — and that confused some users.

				With the application frame, Mac users can now put all the InDesign elements in their own container so that they don’t float freely and other applications don’t peek through. You show the application frame by choosing WindowApplication Frame — doing so makes InDesign for Mac behave like InDesign for Windows. (By default, the application frame is turned off in InDesign for Mac.)

				Conversely, Windows users can choose WindowApplication Frame to hide the application frame so that InDesign for Windows looks like InDesign for Mac. (By default, the application frame is turned on in InDesign for Windows.)

				[image: Remember.eps] The Application Frame menu command is a toggle, hiding the application frame if it’s visible and showing it if it’s hidden. You see a check mark next to the menu option if the application frame is visible. (InDesign uses the same toggling indicator in other menus.)

				[image: newfeature.eps] Above the Control panel is the new application bar, which offers easy access to other Adobe applications, such as Bridge, and access to controls over various view options. It appears by default if the application frame is enabled. When the application frame is hidden, you can show or hide the application bar by choosing WindowApplication Bar.

				The application bar has several handy elements. From left to right:

				The first element is the set of quick-access buttons to Bridge and other Adobe software.

				The second element is the Zoom Level field and pop-up menu, which replaces the Zoom pop-up menu that used to be at the bottom of the document window.

				The third element is the View Options pop-up menu, which lets you hide and show frames boundaries, hidden characters, grids, and other such visual aids from one handy location. These options previously existed but only in a variety of scattered menu options (where they also remain).

				The fourth element, the Screen Mode pop-up menu, duplicates the Screen Mode feature at the bottom of the Tools panel (see Chapter 2).

				[image: newfeature.eps] The fifth element, the new Arrange Documents pop-up menu, gives you fast access to InDesign CS4’s new controls over how document windows are arranged (covered later in this chapter).

				The sixth element, the Workspaces pop-up menu, gives you quick access to the workspaces you’ve defined (as described in the “Working with Panels, Docks, and Workspaces” section, later in this chapter).

				At the far right is the Search menu, which you can use to find files on your computer or via the Adobe Bridge program.

				Pages and guides

				Pages, which you can see on-screen surrounded by black outlines, reflect the page size you set up in the New Document dialog box (FileNewDocument [Ô+N or Ctrl+N]). If in your document window it looks like two or more pages are touching, you’re looking at a spread.

				InDesign uses nonprinting guides, lines that show you the position of margins and that help you position objects on the page. Margins are the spaces at the outside of the page, whereas columns are vertical spaces where text is supposed to go by default. Magenta lines across the top and bottom of each page show the document’s top and bottom margins. Violet lines show left and right columns (for single-page documents) or inside and outside columns (for spreads).

				[image: newfeature.eps] InDesign CS4 introduces a new set of guides, called smart guides, covered in Chapter 10.

				You can change the location of margin and column guides by choosing LayoutMargins and Columns. You can create additional guides — such as to help you visually align objects — by holding down your mouse button on the horizontal or vertical ruler and then dragging a guide into the position you want.

				Page controls

				If you feel like flipping through pages of the document you’re creating, InDesign makes it easy with page-turning buttons and the Page field and pop-up menu. Controls for entering prefixes for the page numbers of sections, and for indicating absolute page numbers in a document that contains multiple sections, are also handy. (An absolute page number indicates a page’s position in the document, such as +1 for the first page, +2 for the second page, and so on.)

				At the bottom left of the document windows is a combined Page page-number field and pop-up menu encased by two sets of arrows. These arrows are page-turning buttons that take you to, from left to right, the first page, the previous page, the next page, and the last page. Just click an arrow to get where you want to go.

				You can also jump directly to a specific document page or master page in several ways:

				Highlight the current number in the page number field (by selecting it with your cursor), enter a new page number or master-page name, and press Return or Enter.

				Use the Go to Page dialog box (Ô+J or Ctrl+J), enter a new page number or a master-page name, and press Return or Enter.

				Choose the desired page from the Page pop-up menu.

				You can also use the Pages panel to navigate your document, as Chapter 4 explains.

				Opening Multiple Document Windows

				If you like to work on more than one project at once, you’ve come to the right program. InDesign lets you open several documents at once. It also lets you open multiple windows simultaneously for individual documents. A large monitor (or having multiple monitors connected) makes this multiwindow feature even more useful. By opening multiple windows, you can

				Display two (or more) different pages or spreads at once. You still have to work on the documents one at a time, but no navigation is required — you have only to click within the appropriate window.

				Display multiple magnifications of the same page. For example, you can work on a detail at high magnification in one window and display the entire page — and see the results of your detail work — at actual size in another window.

				Display a master page in one window and a document page based on that master page in another window. When you change the master page, the change is reflected in the window in which the associated document page is displayed.

				[image: newfeature.eps] Document windows are now by default accessed through a set of tabs below the Control panel, rather than as a series of cascaded windows as in previous versions of InDesign.

				When multiple windows are open, you activate a window by clicking on a window’s title tab or anywhere within its window. Also, the names of all open documents are displayed at the bottom of the Window menu. Choosing a document name from the Window menu brings that document to the front. If multiple windows are open for a particular document, each window is displayed (they’re displayed in the order in which you created them) in the Window menu.

				To show multiple windows on-screen at once, choose WindowArrangeTile. When you choose the Tile command, all open windows are resized and displayed side by side. Or use one of the new window-layout options in the new Arrange Documents pop-up menu’s options (in the application bar). How they display will depend on the option you chose. Either way, note that when you resize any individual document window, the others will be resized accordingly so that they don’t overlap.

				To put all these tiled windows back into their regular tabs so that only one document window is visible on-screen at a time, choose WindowArrangeConsolidate All Windows or choose the Consolidate All Windows option (single-window icon) in the Arrange Documents pop-up menu in the application bar.

				[image: Tip.eps] If you don’t like the tabbed approach to windows and instead want to use the old-style approach of stacked windows, you can. Just choose WindowArrangeFloat All in Windows. You can then move the individual windows around the screen as desired; if they get too messy, choose WindowsArrangeCascade to tell InDesign to make them all neat and tidy in a cascaded stack. If you want to go back to tabbed windows, choose WindowArrangeConsolidate All Windows.

				[image: Tip.eps] To close all windows for the currently displayed document, press Shift+Ô+W or Ctrl+Shift+W. To close all windows for all open documents, press Option+Shift+Ô+W or Ctrl+Alt+Shift+W.

				Not only do you get separate document windows for each open document, you can also create multiple windows for an individual document so that you can see different parts of it at the same time. To open a new window for the active document, choose WindowArrangeNew Window (or use the New Window option in the new Arrange Documents pop-up menu in the application bar). The new window is displayed in its own tab or window, depending on whether you’ve enabled Open Documents as Tabs in the Interface pane of the Preferences dialog box (InDesignPreferencesInterface [Ô+K] or EditPreferencesInterface [Ctrl+K]).

				[image: Remember.eps] You can tell that a document window shows a different view of an existing document by looking at the name of the document in the window’s title. At the end of the document name will be a colon (:) followed by a number. Newsletter.indd:1 would be the document’s first window, Newsletter.indd:2 would be its second window, and so on.

				Tooling around the Tools Panel

				You can move the InDesign Tools panel — the control center for 32 of InDesign’s 33 tools, as well as for 13 additional functions — by clicking and dragging it into position. The Tools panel usually appears to the left of a document (see Figure 1-2).

				[image: Remember.eps] The one tool not directly accessible from the Tools panel is the Marker tool. But you can switch to it from the Eyedropper tool by holding Option or Alt. (Chapter 6 explains its use.)

				[image: Tip.eps] To discover each tool’s “official” name, hover the mouse pointer over a tool for a few seconds, and a Tool Tip will appear, telling you the name of that tool. If the Tool Tips don’t display, make sure that the Tool Tips pop-up menu is set to Normal or Fast in the Interface pane of the Preferences dialog box (choose InDesignPreferencesInterface [Ô+K] or EditPreferencesInterface [Ctrl+K]).

				InDesign gives you one — and only one — tool for each specific job. The Tools panel includes tools for creating and manipulating the objects that make up your designs. The tools in the Tools panel are similar to those in other Adobe products (such as Photoshop, Illustrator, and Dreamweaver). I cover what each tool does in the following sections.

				The small arrow in the lower-right corner of some tools is a pop-out menu indicator. A tool that displays this arrow is hiding one or more similar tools. To access these “hidden” tools, click and hold a tool that has the pop-out menu indicator, as shown in Figure 1-2. When the pop-out displays, click one of the new tools.

				[image: newfeature.eps] You can now also Control+click or right-click a tool to see the “hidden” tools.

				You don’t need to worry about all the tools, so I highlight just those that you’ll need to know to start using InDesign. You’ll likely come across the others as you work on specific tasks, so I cover those in the chapters that introduce those functions.

				
					Figure 1-2:  The InDesign Tools panel (left) and its pop-out tools (center). To see pop-out tools, Control+ click or right-click any tool that has a small triangle appear- ing in its lower-right corner (right).

				

				[image: 388488-fg0102.tif]

				Using the Selection tools

				To work with objects, you have to select them. InDesign provides three tools to do that, letting you select different aspects of objects.

				Selection tool

				The Selection tool is perhaps the most-used tool in InDesign. With the Selection tool, you can select objects on the page and move or resize them. You may want to think of this tool as the Mover tool because it’s the only tool that lets you drag objects around on-screen.

				After you’ve selected the Selection tool, here’s how it works:

				To select any object on a document page, click it. If you can’t seem to select it, the object might be placed by a master page (a preformatted page used to format pages automatically), or the object might be behind another object.

				To select an object placed by a master page, press Shift+Ô or Ctrl+Shift while you click.

				To select an object that is completely behind another object, Ô+click it or Ctrl+click it.

				Direct Selection tool

				The Direct Selection tool is what you use to work on the contents of a frame, not the frame itself. For example, you can use the Direct Selection tool to select individual handles on objects to reshape them or to move graphics within their frames.

				Here’s how the Direct Selection tool works:

				To select an object to reshape it, click the object to display anchor points on the edges (the anchor points are hollow handles that you can select individually, as shown in Figure 1-3). You can drag the anchor points to reshape the object.

				To select objects placed by a master page, Shift+Ô+click or Ctrl+Shift+click, as with the Selection tool. The Direct Selection tool lets you easily select objects behind other objects and select items within groups.

				To move a graphic within its frame, click inside the frame and drag the graphic.

				To move a frame but leave the graphic in place, click an edge of the frame and drag it.

				
					Figure 1-3: Reshape an item with the Direct Selection tool by clicking and dragging an anchor point.

				

				[image: 388488-fg0103.tif]

				Position tool

				Meant to mimic PageMaker’s Crop tool to help former PageMaker users adjust to InDesign, the Position tool, which you access from the pop-out menu in the Direct Selection tool, combines some aspects of the Selection tool with some aspects of the Direct Selection tool:

				As with the Selection tool, you can resize an object’s frame by dragging its handles.

				As with the Direct Selection tool, you can click a graphic and reposition it within the frame by dragging — and that has the effect of cropping the graphic.

				Using the Type tool

				A very frequently used tool, the Type tool lets you enter, edit, and format text. The Type tool also lets you create rectangular text frames.

				Here’s how the Type tool works:

				To create a rectangular text frame, click and drag; hold the Shift key to create a perfect square.

				To begin typing or editing text, click in a text frame or in any empty frame and type away.

				I explain stories and threaded text frames in Chapter 11.

				Using the object-creation tools

				InDesign has a bunch of tools for creating shapes. Part V covers them in more depth, but you should know about a few of them now because they create objects that can contain either text or graphics. Plus, you can also use them to draw your own shapes that you then color or otherwise embellish in your layout. Here’s what you need to know:

				Pen tool: With the Pen tool, you can create simple illustrations. You use the Pen tool, which is modeled after the pen tools in Illustrator and Photoshop, to create paths (both open, such as lines, and closed, such as shapes) consisting of straight and curved segments. Give it a try — it’s fun! (Chapter 7 explains how to use the tool.)

				Type tool: The Type tool lets you draw rectangular text frames, as well as type text inside them.

				Line tool: The Line tool lets you draw freestanding lines (paths) on your page. After selecting this tool, simply click and drag the mouse to draw the line. Holding the Shift key while you click and drag constrains the line angle to 45-degree increments, which is useful for creating straight horizontal and vertical lines.

				Frame and shape tools: InDesign has three frame tools (Rectangle Frame, Ellipse Frame, and Polygon Frame) and three shape tools (Rectangle, Ellipse, and Polygon). The frame and shape tools are redundant because both frames and shapes can hold text or graphics or be empty.

				[image: Tip.eps] Because the frame and shape tools really do the same thing, you might use the frame tool when creating frames that will have their content added later. Why? Because the frames appear with a big X through them, making them easier to spot when looking for frames to fill. The shape tools create frames without that X, so it’s easier to overlook them.

				 To create a rectangle or ellipse, choose the appropriate tool, click  somewhere in the document window, and drag the mouse to another  location. The rectangle or ellipse fills the area. But creating a polygon works differently, as Chapter 7 explains.

				Using the navigation tools

				Several tools, described in the following list, help you navigate your document so that you can move around your pages, move your pages around the screen, and change the degree of magnification to see just part of a page or to see several pages at once.

				Hand tool: The Hand tool lets you move a page around to view different portions of it or another page entirely. After selecting the Hand tool, click and drag in any direction. You can access the Hand tool temporarily without actually switching tools by pressing Option+spacebar or Alt+spacebar.

				[image: newfeature.eps] For a quick way to pan through your document, make sure that the Hand tool is active. Then click and hold the mouse. InDesign will zoom out and display a red rectangle. If you move the mouse, InDesign CS4 stops zooming and instead lets you move the rectangle to a new area of focus. Let go to have InDesign display that part of the document back at the original zoom setting. (This new zoom-and-pan navigator option replaces previous versions’ Navigator panel and its features.) If the autozoom is too fast, you can use the up and down arrow keys instead to manually move through various zoom levels. And if you decide you’ve navigated some place you didn’t mean to, just press Esc — as long as the mouse is still pressed — to start over.

				Zoom tool: With the Zoom tool, you increase and decrease the document view scale. You can highlight a specific area on a page to change its view, or you can click on-screen to change the view scale within InDesign’s preset increments, which is the same as pressing Ô+= or Ctrl+= to zoom in.

				View buttons: At the very bottom of the Tools panel is the Preview Mode button. Its pop-out menu has four preview options: Bleed mode, Slug mode, Preview mode, and Normal mode. Bleed mode shows any objects that bleed (extend) beyond the page boundaries, whereas Slug mode shows the space reserved for information such as crop marks and color separation names used in final output. Preview mode shows you the layout as if it were printed (no guides, bounding boxes, and so on.) Normal mode shows you any interface elements in use, such as guides, hidden characters, and story threads. You can read more about these in Chapter 3. You set these options when you create new documents or by choosing FileDocument Setup.

				[image: Remember.eps] If your Tools panel displays in two columns, you get two buttons at the bottom of the panel: Normal Mode and Preview Mode. In that case, Preview Mode has a pop-out menu that has the Preview, Bleed, and Slug options. To toggle between single-column and two-column views of the Tools panel, click the collapse icon (>> or <<, depending on how many columns are displayed) at the top of the panel.

				Using contextual menus

				InDesign’s contextual menu interface element is very useful. By Control+clicking or right-clicking the document, an object, elements listed in a panel (such as a list of files or styles), the rulers, and so on, you can display a menu of options for modifying whatever it is you clicked. InDesign provides a lot of options this way, and using the contextual menus to access InDesign functions is often easier than hunting through the many regular menu options and panels.

				Working with Panels, Docks,  and Workspaces

				InDesign has so many controls and features that its designers have long ago stopped relying on menu commands to access them all. Instead, most of InDesign’s features are presented as sort of miniature dialog boxes, called panels, that are “windows” of readily accessible options to consider when working in InDesign.

				Working with panels

				Panels provide an interactive method of working with features, one that lets you access the controls quickly. In many cases, panels offer the only method for performing many tasks. Figure 1-1, earlier in this chapter, shows the panels that appear on-screen by default. Note that you can access all panels — except Quick Apply and Tabs — via the Window menu, whether or not the panel is displayed on-screen at the moment.

				Panels typically have three — but sometimes four — controls:

				All panels but the Attributes, Kuler, Pathfinder, Script Label, Story, and Tools panels have a flyout menu, which provides a pop-up menu of controls relevant to that panel.

				Any active panel — meaning it’s displayed in front of any others in its panel group so that you can actually modify its settings — has a close control to remove the panel from the panel group. This control isn’t a way to switch to another panel in that panel group — to do that, just click the tab of the panel you want to work with. (If you remove a panel by mistake, go to the Window menu to open it again.)

				Any active panel has a collapse control (the >> icon). For panels in the dock, clicking that icon collapses it back into the dock. For panels not in the dock (that is, for floating panels), collapsing them shrinks the panel to a much smaller size to get them out of the way. When collapsed, these panels will have a << icon to expand them again. (The Tools panel is an exception: clicking the >> icon changes it to a two-column layout, while clicking the << icon changes it to a one-column layout.)

				Some panels have an expand/collapse control. Click the control to show more or fewer options. (If all options are displayed, clicking the control will shorten the panel and hide some of the advanced options; if only the basic options are displayed, clicking the control lengthens the panel and shows all the options.) Figure 1-4 shows examples of collapsed and expanded panels.

				
					Figure 1-4: An example of a panel collapsed (left) and expanded (right).

				

				[image: 388488-fg0104.tif]

				[image: newfeature.eps] InDesign CS4 adds several new panels: Conditional Text (see Chapter 21), Connections (a quick way to go to Adobe’s online resources), Kuler (see Chapter 6), and Preflight (see Chapter 23). The Buttons panel replaces the old States panel (see Chapter 24). Gone are the Command Bar and Navigator panels.

				To better suit your working style, you can drag panels by their tabs to move them from one panel group to another, drag them out of a dock so that they’re free-floating, or drag them into a dock so that they’re no longer free-floating. The dock feature lets you keep panel groups in one contained area, which helps keep the interface from getting too cluttered. But you’re not forced to work this way: You can still drag panels outside the main dock so that they’re free-floating on-screen.

				Not all panels display in the main dock; less-used panels, such as Data Merge, show up in a free-floating panel group when you open them via the Window menu. Of course, you can always add such panels to the main dock if you use them a lot.

				[image: Remember.eps] All but three panels have a tab, which contains its name, to help you select the desired panel without having to go to the Window menu. The three special panels (without tabs) are the Tools, Control, and Quick Apply panels. Unlike the rest of InDesign’s panels, they can’t be grouped with other panels, so you don’t need a tab to select them. Also, note that the Quick Apply panel is the only one not available via the Window menu; instead, use the lightning-bolt icon to open it from the Control panel and several other panels; you can also choose EditQuick Apply (Ô+Return or Ctrl+Enter).

				To quickly select a panel, just click its tab from its open panel group. When a panel is active, its controls have the following characteristics:

				To display and select an option, click a pop-up menu or an iconic button; the changes take effect immediately.

				To place a new value in a field, highlight the value that’s already in the field and enter the new value. Note that fields accept values in all supported measurement systems, as described in the “Specifying measurement values” section, earlier in this chapter. To implement the new value, press Shift+Return or Shift+Enter. To get out of a field you’ve modified, leaving the object unchanged, press Esc.

				To increase or decrease the value in the field, use the clickable up and down arrows where available.

				To use math to perform changes, enter calculations in the field. You can add, subtract, multiply, and divide values in fields by using the following operators: +, –, * (multiply), and / (divide). For example, to reduce the width of a frame by half, type /2 after the current value in the Width field. Or, to increase the length of a line by 6 points, you can type +6 next to the current value in the Length field. You can also use percentages in fields, such as 50%, which adjusts the current value by that percentage.

				As with the tools, if you make sure that Tool Tips are enabled in the Interface pane of the Preferences dialog box (choose InDesignPreferencesInterface [Ô+K] or EditPreferencesInterface [Ctrl+K]), you’ll get some ideas as to what the panel iconic buttons and fields do.

				[image: Tip.eps] If panels are getting in your way, you can make them all disappear by pressing Tab — as long as the Type tool is not active and the text cursor is active within a text frame, of course. Press Tab to get your panels back.

				Working with docks

				Docks have controls to collapse and expand them. Click the double-arrow iconic button at a dock’s upper corner to collapse or expand the dock. You can also resize the main dock by dragging its resize handle. Figure 1-5 shows the dock controls and what they look like when expanded and collapsed.

				
					Figure 1-5: The collapsed dock controls are the default display (left), but you can expand them to see their options (right).

				

				[image: 388488-fg0105.tif]

				Working with workspaces

				Although you can rearrange InDesign’s panels to suit your needs, rearranging again and again as you switch from one task to another can be a real chore. For example, you may open several of the table- and text-oriented panels when working on text, but then close them and open the graphics- and  positioning-oriented panels when refining layout placement.

				That’s why InDesign lets you create workspaces, which are essentially memorized panel collections. Display the panels you want, where you want them, and create a new workspace by choosing WindowWorkspaceNew Workspace. (Note that this menu option has been called Save Workspace in previous versions.) Give the workspace a name that makes sense, such as Text Panels. That workspace is now available via WindowWorkspaceworkspace name, automatically displaying just those saved panels in their saved locations.

				[image: newfeature.eps] Not only can you save workspaces, you can also tell InDesign CS4 to save any menu customizations made along with the currently opened selection panels into that workspace. (Chapter 2 covers menu customization.)

				Surveying the Menus

				Although InDesign relies heavily on its panels to present its rich capabilities, it also uses traditional menus. In some cases, you can use menus instead of panels; in others, you must use a menu command; in still others, you must use a panel (such as for the data merge and object alignment features).

				InDesign for Windows has nine menus, while InDesign for Macintosh has ten:

				InDesign (Macintosh only): This menu contains the Preferences menu, where you set much of InDesign’s behavioral defaults. You can also configure plug-ins here. Other functions are standard for all Mac programs, including hiding and quitting the program. Note that none of these menu items’ functions are available in panels.

				File: This menu is where you open, create, close, save, export, and set up documents and books; where you import text and graphics; where you print documents and prepare them for commercial printing; and where you set basic user information. Note that none of these menu items’ functions are available in panels, except for the Preflight feature.

				Edit: This menu lets you cut, copy, and paste elements; edit, spell-check, and do search-and-replace operations across entire stories and set up story for the InCopy add-on program; adjust and manage color settings; set up and change keyboard shortcuts and menu preferences; apply various styles to selected objects and text; and undo and redo recent actions. In Windows, you also set preferences and quit the program from this menu. Note that these menu items’ functions, except for Quick Apply, aren’t available in panels.

				Layout: With this menu, you add, delete, rearrange, and navigate pages; change margins and guides; automatically resize a page and its objects; set up page numbering and sections; and create and format tables of contents. Note that these menu options’ functions — except for the Pages, page-navigation, and Numbering & Section Options menus — aren’t available in panels.

				Type: With this menu, you adjust typographic attributes such as size and font, insert special characters, work with footnotes, add placeholder text; and control the on-screen display of special characters such as spaces. Note that the Find Font, Change Case, Type on a Path, Document Footnote Options, Text Variables, Insert Character, Fill with Placeholder text, and Show Hidden Characters menu items’ functions aren’t available though panels. Also note that the separate Notes menu found in InDesign CS3 has moved into this menu as a new menu item.

				Object: You use this menu to change the shape, size, location, and other attributes of objects, such as frames and lines; apply special effects to objects; insert multimedia effects such as buttons; and control display redraw speed. Note that the Text Frame Options, Anchored Object, Corner Options, Clipping Path, and Convert Shape menu items’ functions aren’t available through panels.

				Table: Use this menu to create, change, and format tables and cells. Note that this menu’s functions are available through panels.

				View: This menu lets you control the display of your document, from zoom level to whether guides, rulers, and frame edges appear. Note that none of these menu items’ functions, except for Screen Mode and the zoom controls, are available in panels.

				Window: This menu is where you manage the display of document windows and panels, as well as where you set up and work with workspaces. The window display and workspace functions aren’t available via panels.

				Help: Use this menu to access InDesign’s help system and manage product activation and registration. In Windows, this menu also lets you manage plug-ins. Note that none of these menu items’ functions are available in panels.

			

			
			
		

	
		
			
				Chapter 2

				Making InDesign Work Your Way

				In This Chapter

				Establishing document preferences

				Working with stored preferences

				Setting measurement standards

				Changing text and object defaults

				Working with view defaults

				Setting color and style defaults

				It’s safe to say that the nice people who created InDesign did their best: They put their heads together and made educated guesses about how most people would like to work and, in doing so, established defaults for various settings in the program. When you’re just starting out, simply sticking with the default settings and seeing how they work for you isn’t a bad idea. But after you become more familiar with InDesign and start putting it through its paces, you can change default preferences, views, and measurements, making them better suited to your way of working.

				Preferences are program settings that dictate how InDesign will act in certain instances. InDesign provides extensive preference settings for everything from how objects appear on-screen to how text is managed for spelling and hyphenation.

				Setting InDesign to work your way is easy, and this chapter explains how. I promise not to numb you by covering every single option. Instead, I focus on just those preferences you’re likely to change. As for the rest, feel free to explore their effects after you’re more comfortable using InDesign.

				Setting Document Preferences

				Preferences are settings that affect an entire document — such as what measurement system you use on rulers, what color the guides are, and whether substituted fonts are highlighted. To access these settings, open the Preferences dialog box by choosing InDesignPreferencesdesired pane name (Ô+K) or EditPreferencesdesired pane name (Ctrl+K).

				When you open the Preferences dialog box using the keyboard shortcut (Ô+K or Ctrl+K), InDesign automatically opens the General pane, as shown in Figure 2-1. To access one of the other 16 preferences panes, just click its name from the list at the left of the dialog box.

				[image: Remember.eps] InDesign has two methods for changing preferences: You can change preferences when no documents are open to create new settings for all future documents, or you can change preferences for the active document, which affects only that document. Either way, after you’ve changed the desired preferences settings, just click OK to save those settings.

				[image: Warning(bomb).eps] You can’t reverse changes to preferences after the fact by using the Undo command (EditUndo [Ô+Z or Ctrl+Z]). If you change your mind about a preference setting, reopen the Preferences dialog box and change the setting again.

				
					Figure 2-1: The General pane of the Preferences dialog box.

				

				[image: 388488-fg0201.eps]

				Type preferences

				The Type pane of the Preferences dialog box, shown in Figure 2-2, includes settings that affect character formats, controls whether you use typographer’s quotes, and manages how text appears on-screen. You’re likely to adjust these settings, so here’s a quick review of the main ones:

				
					Figure 2-2: The Type pane of the Preferences dialog box.

				

				[image: 388488-fg0202.eps]

				If Use Typographer’s Quotes is checked, InDesign inserts the correct typographer’s quotes (often called curly quotes) for the current language in use whenever you use quotation marks. For example, for U.S. English, InDesign inserts typographic single quotes (’ ’) or double quotes (“ ”) rather than straight quotes. For French, Catalan, Polish, and other  languages, InDesign inserts guillemets (« »).

				Check Triple Click to Select a Line if you want to be able to select an entire line of text by triple-clicking it.

				When the Apply Leading to Entire Paragraph box is checked, changes to leading (the space between lines) apply to the entire paragraph, as opposed to the current line. In most cases, you want the leading to be applied to all paragraphs, so checking this box is a good idea.

				Adjust Spacing Automatically When Cutting and Pasting Words, which is checked by default, will add or delete spaces around words when you cut and paste.

				When Font Preview Size is checked, menus let you preview how your font choice looks before you actually select it. The pop-up menu at the right of the check box lets you select the size of the preview.

				The options in the Drag and Drop Text Editing section of the Type pane control whether you can drag and drop text selections within a document. By default, Enable in Story Editor is checked and Enable in Layout View is unchecked, which means that you can drag and drop text in the Story Editor but not when working on a layout. You’ll probably want to check them both.

				[image: newfeature.eps] The new options in the Smart Text Reflow section of the Type pane tell InDesign how to create new pages if the text you are placing takes more room than the number pages already in your document (see Chapter 11).

				The Advanced Type pane includes additional typographic settings, shown in Figure 2-3.

				
					Figure 2-3:  The Advanced Type pane of the Preferences dialog box.

				

				[image: 388488-fg0203.eps]

				In the Character Settings section of the Advanced Type pane, you control precisely how superscript, subscript, and small-caps characters are placed and sized:

				The Size fields let you specify the percentages to which superscript and subscript characters are reduced (or even enlarged). The default is 58.3 percent, but you can enter a value between 1 and 200 percent. I prefer 60 or 65 percent, depending on the type size and font.

				The Position fields let you specify how much to shift superscript characters up and subscript characters down. The default is 33.3 percent, but you can enter a value between –500 and 500 percent. I prefer 30 percent for subscripts and 35 percent for superscripts. Note that negative values move text in the opposite directions: down for superscripts and up for subscripts. The percentage is relative to the top of a lowercase letter (the x height) for superscripts and to the baseline for subscripts.

				The Small Cap field lets you specify the scale of Small Caps characters in relation to the actual capital letters in the font. The default is 70 percent, but you can enter a value between 1 and 200 percent.

				The Clipboard Handling pane includes one text-oriented preference: Use the When Pasting Text and Tables from Other Applications setting to choose how formatting is handled when you paste textual objects from other applications. The default is Text Only, which means that you want copied text to look exactly like the existing text in your InDesign layout. The All Information option retains the original formatting when you paste the text into InDesign.

				Composition preferences

				Preferences in the Composition pane, shown in Figure 2-4, do two things:

				
					Figure 2-4:  The Compo- sition pane of the Preferences dialog box.

				

				[image: 388488-fg0204.eps]

				Highlight potential problems on-screen while you’re working

				Establish the behavior of text wrap in certain situations

				Highlighting potential problems

				The Highlight check boxes control whether InDesign calls attention to possible typesetting problems by drawing a highlighter pen effect behind the text. All are unchecked by default unless indicated otherwise in the descriptions that follow:

				Keep Violations highlights the last line in a text frame when it can’t follow the rules specified in the Keep Options dialog box in the Paragraph panel’s flyout menu (TypeParagraph [Option+Ô+T or Ctrl+Alt+T]), as explained in Chapter 14. For example, if the Keep Options settings require at least three lines of text in the text frame, but only two lines fit and thus bump all the text in a frame to the next text frame in the chain, the Keep Options rules are violated, and the last line of text is highlighted.

				When H&J Violations is checked, InDesign uses three shades of yellow (the darker the shade, the worse the problem) to mark lines that may be too loose or too tight due to the combination of spacing and hyphenation settings. (H&J refers to hyphenation and justification.) Chapter 14 covers this topic, too.

				Custom Tracking/Kerning, if checked, highlights custom tracking and kerning (essentially, anywhere you overrode the defaults) in a bluish green. Chapter 15 covers kerning and tracking in more detail.

				Substituted Fonts, which is checked by default, uses pink highlights to indicate characters in fonts that aren’t available and thus for which InDesign has substituted a different font. For output purposes, it’s important that you have the correct fonts, so you typically want to leave this option checked.

				Substituted Glyphs highlights, in pink, any glyphs (special characters) that were substituted. This substitution usually occurs when you have multiple versions of the same font, with different special characters in each version. For example, a file that uses the euro () currency symbol may have been created in the newest version of a font, but a copy editor working on the same file may have an older version of the font that is missing the euro symbol. If uncorrected, the printed symbol may not be what you expected, even if looks right on-screen.

				Setting text-wrap rules

				The three options in the Text Wrap area affect how text flows (wraps) around images and other frames:

				Selecting the Justify Text Next to an Object check box overrides any local justification settings to make text wrapping around an object justified. The text will smoothly follow the object’s shape, rather than keep any ragged margins that can make the wrap look strange. This option comes into play when you wrap ragged (left-aligned or right-aligned) text around objects.

				Skip by Leading, if checked, uses the text’s leading to determine how much space follows an object around which text wraps. This effect is used only if you choose the Jump Object text-wrap option in the Text Wrap panel (WindowText Wrap [Option+Ô+W or Ctrl+Alt+W]).

				Text Wrap Only Affects Text Beneath, if checked, causes only text below (behind) an object to wrap around that object.

				Chapter 16 covers text wrap in detail.

				Measurement preferences

				The Units & Increments pane, shown in Figure 2-5, is where you choose the measurement systems for positioning items.

				
					Figure 2-5: The Units & Increments pane of the Preferences dialog box.

				

				[image: 388488-fg0205.eps]

				Ruler Units area

				The Ruler Units area affects three things: the zero point (by page, by spread, or by the spine), the measurement system displayed on the horizontal and vertical rulers in the document window, and the default values in fields used for positioning objects.

				The Origin pop-up menu determines the zero point (typically, the upper-left corner of the page) for object positions. If you choose Page, the positions of objects are relative to each page’s upper-left corner. If you choose Spread, the positions of objects are relative to the current spread’s upper-left corner. If you choose Spine, objects’ positions are relative to the binding spine of each spread — the very top and center of where the two pages meet.

				With the Vertical and Horizontal pop-up menus, you specify one measurement system for the horizontal ruler and measurements, and the same or different measurement system for the vertical ruler and measurements. For example, you might use points for horizontal measurements and inches for vertical measurements.

				To specify the measurement systems you want to use, choose an option from the Horizontal pop-up menu and from the Vertical pop-up menu. You have the following options:

				Points: A typesetting measurement equal to 1⁄72 of an inch (or 1⁄12 of a pica). To enter values in points, type a p before the value or pt after the value (for example, p6 or 6 pt).

				Picas: A typesetting measurement equal to 1⁄6 of an inch. To enter values in picas, type a p after the value (for example, 6p).

				[image: Tip.eps] You can combine measurements using both picas and points. Keeping in mind that 1 pica is equal to 12 points, you can enter 11⁄2 picas as either 1.5p or 1p6.

				Inches: An English measurement system that is divided into 16ths. To enter values in inches, type i, in, inch, or " after the value. For example, 3i, 3in, 3 inch, and 3" are all read by InDesign as “3 inches.”

				Inches decimal: Inches divided into 10ths on the ruler rather than  16ths. To enter values in inches decimal, include a decimal point as appropriate and type i, in, inch, or " after the value.

				Agates: Typically used in newspapers, an agate is 1⁄14 of an inch, usually the depth of a line in the small type of classified ads, stock tables, and sports statistics boxes. To enter values in agates, type ag after the value — for example, 10ag.

				Millimeters: A metric measurement that is 1⁄10 of a centimeter. To enter values in millimeters, type mm after the value, such as 14mm.

				Centimeters: A metric measurement that is about 1⁄3 of an inch. To enter values in centimeters, type cm after the value, as in 2.3cm.

				Ciceros: A European typesetting measurement that is slightly larger than a pica. To enter values in ciceros, type c after the value — for example, 2c.

				Custom: This option lets you set a customer number of points as your measurement unit, placing a labeled tick mark at every point increment you specify. You get to customize the number of tick marks between the labeled marks by entering a value in the Points field. For example, if you enter 12 in the field, you get a tick mark at each pica because a pica contains 12 points. A good way to use this option is if you need to have the rulers show tick marks at whole-line increments; in that case, if your leading is 8 points, you’d set the Custom field to 8.

				Keyboard Increments area

				The Keyboard Increments area lets you customize the way the keyboard arrow keys work. You can use the arrow keys to move selected objects right, left, up, or down. You can also use the arrow keys and other keyboard shortcuts to change some text formatting. The options are

				Cursor Key field: When you select an object with the Selection tool or the Direct Selection tool, you can move it up, down, left, or right by using the arrow keys on the keyboard. By default, the item moves 1 point with each key press. You can change the increment to a value between 0.001 and 8p4 (1.3888 inches). If you use a document grid, you can change the increment to match the grid lines.

				Size/Leading field: The value in this field specifies by how many points the leading or font size is increased or decreased when done with keyboard commands. You can enter a value between 0.001 and 100 (the default is 2).

				Baseline Shift field: To shift the baseline of highlighted text up or down, you can click in the Baseline Shift field on the Character panel and then click the up or down arrow on the keyboard. The default for the Baseline Shift increment value is 2 points, which you can change to any value between 0.001 and 100.

				Kerning field: To kern text with keyboard commands, you position the cursor between two letters and then press Option+→ or Alt+→ to increase kerning, and press Option+← or Alt+← to decrease kerning. By default, each press changes kerning by 1⁄50 of an em — shown on screen as 20⁄1000 em. You can change this value to anything between 1 and 100, in increments of 1⁄1000 of an em. (An em is a space the width of a capital M, a commonly used space in professional typography.)

				Typographic terminology 101

				Publishing tools like InDesign use specialized terms, some of which appear in the Preferences dialog box:


				Baseline: This term refers to the invisible line that text sits on in each line. Except for a few characters like g and p that poke below it, all characters rest on this baseline.


				Kerning: This refers to an adjustment of the space between two letters. You kern letters to accommodate their specific shapes. For example, you probably would use tighter kerning in the letter pair to than in oo because to looks better if the o fits partly under the cross of the t.


				Leading: This term, also called line spacing, refers to the space from one baseline to another.


				Tracking: Tracking determines the overall space between letters within a word.

				Document defaults

				InDesign also lets you change the default page size, margins, and columns in new documents; the default attributes of guides; and the way layouts are adjusted. You don’t modify these settings in the Preferences dialog box; instead, to modify document defaults, first make sure that no documents are open and then choose the following:

				FileDocument Setup (Option+Ô+P or Ctrl+Alt+P): The Document Setup dialog box lets you change the default settings in the New Document dialog box for the Number of Pages, Page Size, Facing Pages, and Master Text Frame, as well as for bleeds and slugs if you click the More Options button.

				LayoutMargins and Columns: The Margins and Columns dialog box lets you change the default settings in the New Document dialog box for the Margins and Columns areas.

				LayoutRuler Guides: This command opens the Ruler Guides dialog box where you adjust the View Threshold and Color for all new guides.

				LayoutLayout Adjustment: The Layout Adjustment dialog box lets you resize entire layouts and modify how they are resized.

				[image: Tip.eps] If you’re unhappy with the preferences and defaults you’ve established, you can revert InDesign to all its default settings. To revert all preferences and defaults, press Control+Option+Shift+Ô or Ctrl+Alt+Shift when launching InDesign.

				Working with stored preferences

				Some preferences in InDesign are stored in files that you can share with other users, so the preferences can be consistently used in a workgroup. These preferences include keyboard shortcut sets, color swatch libraries, document setups, workspaces, and scripts.


				Some of these stored preferences — such as document setups and printing setups — are called presets, and the files that store them reside in the Presets folder within the InDesign application folder. When you save a preset, InDesign automatically updates the presets file. You can then copy that preset file to another user’s Presets folder.


				To create presets, look for menu items with the word preset in them — examples are Adobe PDF Presets, Document Presets, and Print Presets in the File menu; and Transparency Flattener Presets in the Edit menu. Also look for the Save Preset option in some dialog boxes. To use a preset, look for a pop-up menu with the word preset in them in dialog boxes; for example, you would use the Document Preset pop-up menu in the New Document dialog box to create a new document using a specific preset’s settings.


				InDesign has other types of stored preferences whose settings are also stored in separate files, also stored in the Presets folder. But you won’t see options labeled Presets in the InDesign user interface to work with them. These stored preferences include Keyboard Shortcuts, Menus, and Color Profiles options in the Edit menu and the Workspace option in the Window menu. You can share these settings by copying them to other users’ Presets folders.


				Another kind of preference is typically stored as part of a document: master pages, text variable, color swatches, and the various types of text, stroke, and object styles available through a series of panels. These preferences can be imported from other documents using the Load command in the various panels’ flyout menus and in some dialog boxes. Most presets — such as document presets, print presets, trap presets, and Adobe PDF presets — can also be loaded and saved this same way. In addition, you can save color swatches to files to be shared with other Adobe applications using a Save Swatches command in the Swatches panel’s flyout menu.

				Modifying Defaults for Text and Objects

				When you create a new document, start typing, or create a new object, your work conforms to default settings. You can change these settings. For example, by default, a new document is always letter-sized, but if you design only posters, you can change the default.

				You may need to work with InDesign for a while to figure out which settings you prefer. When you identify a problem — for example, you realize that you always end up changing the inset for text frames — jot down a note about it or close all documents right then. When no documents are open, change the setting for all future documents.

				Text defaults

				When you start typing in a new text frame, the text is formatted with default formats and attributes. You can also choose to show invisible characters such as spaces and tabs by default; otherwise, you need to manually activate character visibility in each text-heavy document. To modify text defaults:

				Choose default options for character formats such as Font Family, Font Size, and Leading from the Character panel. Choose TypeCharacter (Ô+T or Ctrl+T).

				Choose defaults for paragraph formats, such as alignment, indents, spacing, and so on, from the Paragraph panel. Choose TypeParagraph (Option+Ô+T or Ctrl+Alt+T).

				Choose defaults for the [Basic Paragraph] style, which is what all unstyled imported text, as well as text entered in a new text frame in InDesign, will use. Choose TypeParagraph Styles (Ô+F11 or Ctrl+F11).

				Activate Optical Margin Alignment. Choose TypeStory. This option adjusts the left position of characters along the left margin to make the left edges look more pleasing, by letting the top of a T, for example, hang slightly to the left of the margin, even if that means the characters aren’t strictly aligned. (Because optical margin alignment works best for display type rather than body type, it’s unlikely that you’ll activate optical margin alignment as your default setting.)

				Show Hidden Characters is a good thing to activate if you always end up turning on Show Hidden Characters when you’re editing a document. Choose TypeShow Hidden Characters (Ô+Option+I or Ctrl+Alt+I), or choose Hidden Characters from the View Options pop-up menu in the application bar. Hidden characters are spaces, tabs, and so on that print “blank” but that you may want to see on-screen to make sure that you have the right character in use. InDesign has a unique on-screen symbol for every kind of space, tab, indent-to-here, and other such “blank” characters.

				Object defaults

				When you create new objects, they’re based on default settings. For example, you can specify how text wraps around objects. To modify object defaults, use the following commands:

				Specify the default Columns, Inset Spacing, First Baseline, and Ignore Text Wrap settings for new text frames using the Text Frame Options dialog box. Choose ObjectText Frame Options (Ô+B or Ctrl+B).

				Choose defaults for the [Normal Graphics Frame] and [Normal Text Frame] styles, which are what all new frames created in InDesign will use. Choose WindowObject Styles (Ô+F7 or Ctrl+F7).

				Specify how text will wrap around all new objects. Choose WindowText Wrap (Ô+Option+W or Ctrl+Alt+W).

				Choose a style for the corners of all new frames except those created with the Type tool. Choose ObjectCorner Options.

				Specify the default attributes of clipping paths imported into graphics frames. Choose ObjectClipping PathOptions (Option+Shift+Ô+K or Ctrl+Alt+Shift+K).

				Specify other default properties of objects. For example, if all objects you create are stroked (framed), specify a weight in the Stroke panel. Choose WindowStroke (Ô+F10 or Ctrl+F10), WindowSwatches (F5), WindowGradient, or WindowAttributes.

				Specify the default number of sides and the inset for the first new polygon in a new document. Double-click the Polygon or Polygon Frame tool to open the Polygon Settings dialog box (there is no menu command or keyboard shortcut).

				Modifying Defaults for Views

				InDesign provides controls for several view attributes, including zoom level, frame boundaries, and grids.

				The application bar contains the Zoom Level field, which shows the current zoom percentage. You can type in a new value any time. Immediately to its right is the Zoom Level pop-up menu, which also lets you change the document’s view. The view can be between 5 percent and 4,000 percent in 0.01-percent increments.

				[image: newfeature.eps] If you use a MacBook Air or a 2008-or-newer-model MacBook Pro, you can use gestures on its Multi-Touch trackpad (first introduced in the iPhone) to zoom in or out. Use the pinch gesture (two fingers moving closer) to zoom in and the expand gesture (two fingers moving apart) to zoom out. (If Apple adds the Multi-Touch to other Macs in the future, they would support these gestures in InDesign.)

				[image: newfeature.eps] The Zoom Level controls have moved from the bottom of the document window in previous versions of InDesign to the new application bar in the CS4 version. Gone is the ability to change the view without taking your hands off the keyboard by pressing Option+Ô+5 or Ctrl+Alt+5. Still, you can press Ô+= or Ctrl+= to zoom in, or Ô+– or Ctrl+– to zoom out, in increments. Or, with the Hand tool selected, just click and hold the mouse and let InDesign zoom  automatically; let go when you’re at the desired zoom level.

				You can also control which layout visual aids display, using options in the View menu.

				For example, if you prefer not to view the edges of frames, you can hide them. Similarly, you can hide the visual indicators for the threads indicating which frames flow to and from the selected text frame.

				If you want to start with a document-wide grid (see Chapter 10), you can. Settings you can modify in the View menu include

				Show the links between text frames. Choose ViewShow Text Threads (Option+Ô+Y or Ctrl+Alt+Y).

				Hide the edges of frames. Choose ViewHide Frame Edges (Control+Ô+H or Ctrl+H).

				Hide the horizontal and vertical ruler. Choose ViewHide Rulers  (Ô+R or Ctrl+R).

				Hide margin, column, and layout guides. Choose ViewGrids & GuidesHide Guides (Ô+; [semicolon] or Ctrl+; [semicolon]).

				Hide smart grids. Choose ViewGrids & GuidesSmart Guides  (Ô+U or Ctrl+U).

				Show the baseline grid established in the Grids pane of the Preferences dialog box. Choose ViewGrids & GuidesShow Baseline Grid (Option+Ô+’ or Ctrl+Alt+’).

				Show the document-wide grid established in the Grids pane of the Preferences dialog box. Choose ViewGrids & GuidesShow Document Grid (Ô+’ or Ctrl+’).

				InDesign has another place to set view settings: in the Pages panel’s flyout menu, choose ViewShow/Hide Master Items. When you choose Show Master Items, any objects on the currently displayed document page’s master page are displayed. When you choose Hide Master Items, master objects on the currently displayed page are hidden. This command is  page-specific, so you can show or hide master objects on a page-by-page basis.

				Adding Default Colors and Styles

				If you’re a creature of habit, you may find yourself creating the same colors, paragraph styles, character styles, table styles, and object styles over and over again. Save yourself some steps by creating these features when no  documents are open; when you do so, the features will be available to all future documents.

				To set up these often-used items, use the New command in the flyout menus for the following panels: Swatches (F5), Character Styles (Shift+Ô+F11 or Ctrl+Shift+F11), Paragraph Styles (Ô+F11 or Ctrl+F11), Table Styles (no shortcut), Cell Styles (no shortcut), and Object Styles (Ô+F7 or Ctrl+F7). You can also use the flyout menus’ Load commands to import colors and styles from existing documents instead of creating them from scratch.

				Chapter 6 covers color swatches, Chapter 9 covers object styles, Chapter 13 covers character and paragraph styles, and Chapter 19 covers table and cell styles in more detail.

			

		

	


End of sample




    To search for additional titles please go to 

    
    http://search.overdrive.com.   
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